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1 Les tables multidimensionnelles SAS®

1.1 Leurs objectifs

Les tables multidimensionnelles SAS font parties de la solution OLAP (OnLine Analitycal
Processing) fournie par SAS.

Leur structure répond & une problématique élémentaire : fournir aux utilisateurs un acces

simple et rapide aux données. Elles sont enregistrées et stockées selon des axes définis et
les indicateurs nécessaires au fonctionnement de vos applications sont pré-calculés.

1.2 L’'offre SAS

Cette offre est intégrée dans le produit SAS/MDDB® Server. Ce module permet la
construction et la mise a jour des structures multidimensionnelles.

Ce document est réalisé en se basant sur la version 8.2 du Systéeme SAS.
1.3 Les pré-requis

Pour la construction et la mise a jour des tables multidimensionnelles, il suffit d’avoir une
licence SAS/MDDB Server en plus de I’acces aux ressources SAS.

Cette licence n’est pas obligatoirement nécessaire dans I’environnement d’exploitation,
elle I’est seulement lors de la construction des structures.

Ces pré-requis ne concernent donc que la mise en place des données nécessaires au
fonctionnement des applications OLAP. Pour leur exploitation, le détail des pré-requis
sera donné en fonction des solutions mises en ceuvre et des modules SAS utilisés.

1.4 La gestion de sources multidimensionnelles SAS

Comme nous I’avons vu précédemment le module SAS/MDDB Server offre la possibilité
de créer et de mettre a jour des structures multidimensionnelles.

Ces opérations se font par I’intermédiaire de la procédure MDDB. Pour le détail de la
syntaxe, il faut se référer & la documentation « SAS OnlineDoc® documentation »,
SAS/MDDB, Building and updating MDDBS.

Deux exemples sont fournis dans ce document. Le premier, ci-dessous, montre la création
d’un « Mddb » (Multi Dimensional Data Base) contenant plusieurs sous-tables et deux
variables d’analyse auxquelles sont associées plusieurs statistiques.



proc mddb data = sdonnees.fmtsale out = sdonnees.fmtmddb ;

class month division product quarter prodtype region country year;

hierarchy year quarter month / display=YES name="Temps";

hierarchy year quarter month product ;

hierarchy country region division / display=YES name="'Géographie";
hierarchy country region division product ;

var predict actual / sum ;
run ;

Exemple 1 : création d’un Mddb

Dans cet exemple, les hiérarchies « Temps » et « Géographie » seront visibles lors de
I’exploitation des données (attribut display=YES).

proc mddb data = sdonnees.fmtsale In = sdonnees.fmtmddb
out= sdonnees.sasmddb;

removehier year quarter month / name="Temps';

run ;

Exemple 2 : mise a jour d’'un Mddb

Cing solutions s’offrent a vous pour créer vos structures multidimensionnelles:
~la procédure Proc MDDB (vue ci-dessus)
I"interface SAS/EIS®
- I’interface SAS/Warehouse Administrator®
- les classes SAS/MDDB Server
- SAS® Enterprise Guide®

2 La définition des méta-données

Afin d’utiliser ces sources de donnees, que ce soit par SAS ou d’autres produits du
marché, il est nécessaire de les déclarer dans un référentiel.

A travers ce référentiel, le CMR (Common Metadata Repository), vous allez référencer
les Mddbs a utiliser, et leur associer des attributs supplémentaires en fonction du besoin.
Le CMR comprend les utilitaires de création de I’environnement (REPOSMGR) et de
déclaration des sources de donnees (Metabase).



2.1 Les preé-requis

Pour utiliser le CMR, une licence SAS/EIS ou SAS/MDDB Server est nécessaire.
Disposer de I’une de ces licences entraine la création d’un module virtuel SAS/MDDB
Common Products qui va contenir les ressources nécessaires a I’ utilisation du CMR

2.2 L'environnement du CMR

Il se compose de deux éléments principaux qui sont le Repository Manager et le(s)
Repository.

Le Repository Manager initialise un environnement et gere les repository dans lesquels
seront déclarées les sources de données. Physiquement, un repository manager ou un
repository se compose de tables et de catalogues. Dans les 2 cas, il ne peut en avoir qu’un
seul par répertoire.

Dans notre cas, nous allons utiliser la structure suivante sur notre serveur :
4 Repository Manager C:\Environnement SAS\Multidimensionnel\Rposmgr
v Repository C:\Environnement SAS\Multidimensionnel\Repository1

La création du Repository Manager se fait donc a I’aide de I’utilitaire Reposmgr. Pour
accéder a cet environnement, il suffit de saisir « Reposmgr » en ligne de commande et de
valider.

¥ Repository Manager g | 4
Common Metadata Repository Manager
B, : oy i
Setup Repository Mar. Repository Registration Attribute Dictionary

il

Aszociation Manager [tilities Exit

Figure 1 : fenétre principale du Common Metadata Repository Manager

Une fois la fenétre visible, il faut cliquer sur « Setup Repository Mgr ». Seul le chemin du
nouveau repository manager est a sélectionner. Aucune option n’est nécessaire. Lors de la
demande de poursuite du processus de création apres avoir cliqué sur le bouton « Ok », il
faut répondre « Oui ». La confirmation de la création doit alors s’afficher.



= Repository Manager Setup i ;IEIEI

R epozitory tanagar Setup

Lirar:  [RPOSMGR

Path: IC:‘.Environnement SAS\Multidimensionnel R posmar Browsze. .. i

Options: I

I white values to systern registry,

Ok Restore Defzult Cancel Hep

Figure 2 : fenétre de gestion du Repository Manager

Une fois cette opération effectuée, il faut déclarer le repository. L’acces se fait en cliquant
sur « Repository Registration » a partir du menu principal.

Pour le créer, il faut cliquer sur « New » puis donner un nom au repository, un libellé et
sélectionner le répertoire qui va contenir sa définition. La validation se fait en cliquant sur
« Ok ».

itor'y Regl an__
usn.
Repositon ‘ Id | Fath Descrphion Engine Optionzs ;I
- EMPTY - pOOB00045.
¥ register Repository (New) I ] 2
Reqister Repositary
_! Repository Name: [Soures
4
Path: !E'\Enwrnnnement SAS\MultidimensionnelsFer Browse: I
MHew | Deseription: |Sources MODE]
Engire: |
Library Opticns: |
I Readonly access.
(6]8 | Cancel Help

Figure 3 : fenétre de création du Repository

Il reste maintenant a enregistrer les sources de données au sein de ce repository.

2.3 Les données

Une interface simple assure la gestion des données d’un repository. Les opérations portent
sur I’ajout, la suppression de sources de données ainsi que sur I’ajout, la modification et la
suppression de leurs attributs.



L"accés se fait en validant I’instruction « Metabase » en ligne de commande SAS.

o]

Repository: Source [E] Host

ISources MDDE -LOCAL - A‘%’:J M

o | 2 | | >

fAdd Lolumns | Dolote flid | Feive |Z}<=,>2<=,>§;<=z|

Loy Henans Yiew

Figure 4 : fenétre principale de gestion des données d’un repository

La fenétre principale se decompose en deux zones bien distinctes. La liste de gauche
contient les sources de données tandis que celle de droite donne les attributs de la source
sélectionnée. Les boutons situes en dessous donnent les actions qu’il est possible de
réaliser.

Pour enregistrer une source de données, il faut ainsi sélectionner le bouton « Add » sous la
liste de gauche, choisir le Mddb a ajouter puis le transférer dans la liste « Selected » en
double-cliguant sur cette méme source dans la liste « Available ».

Metabase
Fiepositon: Source [E] Host -
Sources MDDB ;@;l |'|—U[:ﬁ|-' i Close |
X
rF’at)ﬁ
|IC:\Envirannenent 8aS\Travail)Sdonr | = | [-LocAL- &
PROMDDB _Cancel |
PRDSALE
SASMBI View
SASMDDB
Help

i

Figure 5 : fenétre de sélection des sources de données

La validation du choix s’effectue en sélectionnant le bouton « Ok ». La sélection de cette
source dans la fenétre principale de la « Metabase » permet alors de voir les attributs dans
la liste de droite.

L’utilisation de cette source avec certains produits va nécessiter I’ajout de I’attribut
OLAPMETA. Cet attribut va permettre d’externaliser les méta-données du cube ayant cet



attribut. Pour se faire, aprés avoir sélectionné la source de données dans la fenétre
principale, il faut cliquer sur le bouton « Add » sous la liste « Attributes » et choisir
I’attribut « Olapmeta ».

He itr: Source [E]
|Sources MDDE

BASETABL SDONNEES .FMTSALE
HIERARCH Source.SLIST.H.SLIST

HOST MTSERV
LABEL MDDE SDONMNEES . FMTHDDE
Attributes 0K |
COMPSRY Compute Server 0
CONTROL  Control data set (experimental) D ml
EP ILOG Table post-processing 0
MAPINFD  Map navigation table D Help |
1] DLAPMETA  Open OLAP Server E
T PARETO Pareto data set D
| PROLOG Table pre-processing D
Em -
m B

Figure 6 : sélection de I’attribut Olapmeta

Pour conserver les hiérarchies (Temps et Géographie) existantes, il faut répondre « Oui »
aux deux questions posées suite a la validation du choix de P’attribut. La fenétre de
propriétés de I’attribut « Olapmeta » apparait alors. Il peut étre validé en I’état.

3 L’exploitation des données multidimensionnelles

3.1 L’architecture

L’organisation des méta-données et des données est a adapter en fonction des solutions
choisies. Ce document se focalise sur la mise en ceuvre technique au sein des produits
exploitant les tables multidimensionnelles, la partie architecture sera donc peu deécrite. Il
faut néanmoins étre conscient de son importance lors de la mise en place d’une
application décisionnelle, du fait des volumes de données a traiter et des performances
attendues par les utilisateurs.

3.2 L’exploitation interne

3.2.1 SAS/EIS®

L utilisation de ce module fait partie des solutions clientes dites « lourdes » puisque SAS
doit étre installé sur le poste client ou sur un serveur de fichiers accessibles aux
utilisateurs.

Les modules Base SAS, SAS/GRAPH®, SAS/FSP®, SAS/AF® et SAS/EIS® doivent étre
sous licence lors du développement des applications. Il n’est pas nécessaire de posséder
SAS/FSP® et SAS/AF® lors de la phase de production.



Pour exploiter la source de données que nous avons créée, il faut accéder a
I’environnement de développement de ce module, en validant la commande « Eis » ou par
le menu, « Solutions > Development and Programming > Eis / Olap Application Builder »
puis en double-cliquant sur I’icéne « Build EIS ».

L’écran accedé permet la création d’applications EIS (objets) selon les fonctionnalités
désirées. Ces objets sont enregistrés dans une « Database » (possibilité d’en avoir
plusieurs par répertoire).

=il SA5,/ETS; Build EIS =101 =]

Path

Host
IE :\Environnement SAS%Travail'Systeme i |°°°°°°@®ii [-LocaL- | & !

Application Database: APPLEIS B
ose |
|ﬁ|:||:|l ication Eis ll
Name ‘ Description ‘ Type _1_]

il of

Find | Add L fiete Fafie Towt

Figure 7 : fenétre Build Eis

Pour ajouter un objet, il est nécessaire de cliquer sur le bouton « Add ». Dans notre
exemple nous allons utiliser un tableau offrant des fonctionnalités basiques d’exploitation
des tables multidimensionnelles. Dans la famille d’objet « Multidimensional Reports », il
faut choisir I’élément « Multidimensional Report » et valider grace au bouton « Build ».

Plusieurs champs sont alors a remplir : nom de I’objet, le libellé associé, puis les données
de I’objet avec le nom de la table source utilisée, la répartition des dimensions et
indicateurs dans le tableau ainsi que les statistiques qui leur sont associées. Au final, le
résultat suivant est obtenu.

=i SAS/EIS Multidimensional Report il DI_{l
[l
—E| Name: [VENTES oK |
Description: IHésu]tats et ventes Cancel I
Test i
Table: |MDDB SDONMEES . FMTHDDB -
Subset. .. I
Columns: |Down: Géographie — Customize. .. i
ficross: Temps
finalysis: Actual Sales Predicted. .. fAidvanced. . . i
Help I
Statistic: [Actual Sales : Sum -
Predicted Sales : Sum _J:NJ

Figure 8 : propriétés de I’objet Multidimensional Report



Il est possible de valider I’objet en cliquant sur le bouton « Test ». Un fonctionnement
identique au mode production est réalisé. Dans notre exemple, nous obtenons le résultat
ci-dessous, sans avoir paramétré I’aspect visuel de I’objet (couleur, image, ...).

= Résultats et ventes - : =10 x|

ear Annge 1933 Année 1934 ;I
Actual Salesl Predicted 5 ales| Actual Salezl Predicted Sales
Country Sum | Sum Sum | Sum

Est $64.130.00 $62.426.00 $63,355.00 $58.220.00
Ouest| $56230.00 $56.,903.00 $62.615.00 $55.470.00
Allemagne $127404.00  $117.119.00 $118,594.000  $114.435.00
Etatz-uniz ¥121053.00 $123,763.00 %1 16,236.00 F117,959.00

Canada

i o

Figure 9 : utilisation de I’objet Multidimensional Report

Le menu déroulant obtenu par un simple clic droit sur I’objet, permet d’accéder a
différentes fonctionnalités, telles que la navigation dans les données, la modification ou
I’ajout des variables calculées, I’acces aux données de détails...

Il est bien entendu possible d’exécuter cet objet, et tout autre objet SAS/EIS, sans devoir
passer par I’environnement de développement. La commande RUNEIS est utilisée a cet
effet.

3.2.2 SAS/AF®

Ce module requiert une installation identique au module SAS/EIS. Par contre, les pré-
requis ne sont pas identiques puisque les modules nécessaires en développement sont Base
SAS, SAS/GRAPH, SAS/FSP, SAS/MDDB Server et SAS/AF. En production ce dernier
n’est pas nécessaire.

SAS/AF se positionne comme un module de déeveloppement d’applications de type saisie,
consultation de données. Il n’a, a ce titre, pas vocation a manipuler des données
multidimensionnelles et a proposer les fonctionnalités qui y sont liees.

L’acces aux données multidimensionnelles a travers le module SAS/AF se restreint donc,
sans trop de code SCL, a la visualisation de données.

Quelques étapes sont a suivre pour voir les données d’un Mddb. Dans un premier temps, il
faut nécessairement créer une entrée de type Frame. L’acces aux données se fera a I’aide
de I’objet « Table Viewer Control » qu’il faut insérer dans I’entrée, en faisant un glisser-
lacher par exemple.
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En plus de ces opérations, le code SCL suivant doit étre associé a I’écran. 1l est extrait de

la documentation SAS. Il a été adapté aux données utilisées pour la réalisation de ce
document.

Exemple 3 : code SCL associé a I’écran SAS/AF

L’exécution de la fenétre donne le résultat ci-dessous.

46945300 $63.43800 $7302000 $68,827.00 $76,167.00
$7257400 6661200 $7R26000 $77.368.00 $73085.00
$142,037.00 $136,110.00 $148,260.00 $145,195.00 $143,232.00

Figure 10 : visualisation des données d’une table multidimensionnelle

Dans notre exemple, il s’agit d’un exemple statique. Il est tout a fait possible de

paramétrer la liste de classes accessibles et de laisser I’utilisateur choisir celles qu’il
souhaite croiser et visualiser.
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3.2.3 SAS® Enterprise Reporter®

Le produit SAS Enterprise Reporter va permettre le méme type d’acces aux données
multidimensionnelles que le module SAS/AF.

La visualisation des données ne sera pas dynamique. Les rapports construits se baseront
sur les données du Mddb sans offrir les fonctionnalités de navigation (expand, drill, ...).

En terme de pré-requis, les modules varieront en fonction du type d’installation effectuée :
Standard Edition ou SAS System Edition.

L’edition standard comprend I’accés a un ensemble de modules: Base SAS,
SAS/GRAPH, SAS/FSP, SAS/CONNECT et plusieurs SAS/ACCESS (Oracle, ODBC,
PC Files Formats et Sybase-SQL Server).

L’édition Systeme requiert les modules Base SAS, SAS/GRAPH, SAS/FSP.

Pour créer un rapport, il faut commencer par définir un « Infofolder » qui va pointer sur le
répertoire ou la librairie contenant le MDDB. Si les données sont sur un serveur distant, il
faut définir un serveur au préalable (Tools > Server definitions). La création de
I’Infofolder se fait a partir de la fenétre « Create Infofolder » accessible a partir de « Tools
> Create Infofolders ».

MName: IDossier Mddb | Comment:

S e —
Aptomaticdoine: | Dizable Autalain -
—Faolders Updated:  [Mew] _I

Server Databaze Location

Library: SDONMNEES

= Senver
) My Computer Database System; CAS -
& Mon serveur Windows ~Path/5aS Libran
C! Path
|
(= 545 Library
Server Definitions...
T
ok | Cancel What's This? |

Figure 11 : alimentation de I’infofolder d’Enterprise Reporter

La fenétre ci-dessus montre la création de I’infofolder « Dossier Mddb » qui sera alimenté
avec les données de la librairie SDONNEES se trouvant sur le serveur MYSERV. Au
niveau de I’écran « Create Infofolder », il faut cliquer sur le bouton « Add » pour pouvoir
ajouter la bibliotheque souhaitée.

Suite a cette déclaration, il faut sélectionner ce dossier dans la fenétre « Select infofolder »
(Data > Select infofolder) afin de choisir les données nécessaires a la création du rapport.
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Il faut alors réaliser un « drag and drop » des données a utiliser dans la zone « Report
data » ou se servir de I’icone =2l

x4
General 1 Flller] 1
& LR R AR HE S NN B
All: Report Data:
[=jDassier Mddb = [ Actusl Sales
ZSDONMEES [5A5) o [E] County
o [E] Division
2o [E] Month
¥ [ Predicted Sales
So [E] Product
o [E] Product bype
o [E] Ouarter
o [E] Region
so [E] Year
ok | Cancel | whavsThis? |

Figure 12 : sélection des données du rapport, issues du Mddb Fmtmddb

Il ne reste plus qu’a construire le rapport avec les données choisies dans I’InfoCenter. Les
objets qui vont constituer ce rapport sont a insérer dans la zone principale puis a alimenter
avec les données. Tout ceci avec le « glisser — lacher ».

Master

Year Année 1993 Année 1994 &
Product Predicted Sales ‘ Actual Sales Predicted Sales | Actual Sales
BED §13551.00 §11,057.00 §2,467.00 12,4965.00
CHAIR §11819.00 $13818.00 1185200 }13528.00
DESK $11744.00 12,396 00 §12.32000 113557 00
SOFA §12237.00 14 544.00 §13,115.00 W10 62800
TABLE $10530.00 $12,860.00 §13,966.00 ¥13542.00

4 o

Figure 13 : extrait de rapport simplifié se basant sur les données d’un Mddb
Méme si les fonctionnalités de navigation sont absentes, du fait de la spécificité du

produit, il reste intéressant de noter que les données multidimensionnelles peuvent étre
utilisées pour produire des rapports élaborés.

3.2.4 SAS® Enterprise Guide®

Le poste client qui utilise SAS Enterprise Guide n’a besoin d’aucun pré-requis en terme
de modules SAS. Le serveur, quant a lui, nécessitera la licence des modules SAS
Integration Technologies ainsi que SAS OLAP Server.
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Les tables multidimensionnelles sur lesquelles nous souhaitons travailler doivent avoir
obligatoirement I’attribut « OLAPMETA » d’assigné (voir précédemment) et les librairies
de travail doivent étre allouées, notamment celle ou se situe le cube SAS.

A la connexion sous SAS Enterprise Guide, il ne reste plus alors qu’a créer un projet et a
accéeder au cube. Pour cela, il faut qu’il apparaisse lorsque I’élément « Cubes » est déplié.

raries
WWOIRE,
TEMPOOO
SDOMMEES
Loz AL
SASHELP

; RPCOEMGR.
| E-[2P SASUSER
- Cubes

. [P SDONMNEES.FMTMDDE (SOURCE)
-] Files

o

Figure 14 : Table multidimensionnelle accessible sous « Cubes »

Il faut alors double-cliquer sur le cube pour qu’une fenétre permettant la manipulation des
données multidimensionnelles apparaisse (MDDB Viewer). Des représentations sous
forme de tableau et de graphique sont faites par défaut.

Background Fow and Columr: el
Trrgs 1583 | Annes 1554
i‘i"‘e—l E‘?—_!__Twﬁén - 360,211.00 | $346,064.00
Heasures W e R [Canada 118,325.00| 511368000
T n Temps | |ecaraphiec AL Aienaone 17 118 00| 114 436,00
" [Frets s Tl 1 75.755.00 | §117 84 00
i
=«
0 I— 3
+ ¥
_I__I SUM of PREDICT
Apply | 800000
7annnn
= Geéographie AL 00000
B Canada SO0
- Allemagnie 400000
- Ebatseuis 20000
200000 Temps
e 3 | M T
Géographie | annge 1333
g Bl Arnée 1994
2
@
By
g : 7
2 g 2 z
% B 5
= B a <
E 2 | i
T 51 Géographie A Weasures Jy Temps 7 [ @ ] @

Figure 15 : fenétre de manipulation du Mddb sous Enterprise Guide

L’utilisateur peut ainsi accéder aux données multidimensionnelles grace a une interface
simple.
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3.2.5 WebAF™

Ce produit, comme le suivant (WebEIS), fait parti du package AppDev Studio™. Il est
destiné au monde Web puisqu’il permet la création d’interfaces graphiques livrées sous
forme de servlet, applet, ...

L’ acces aux données se fait en passant par un serveur SAS déclaré lors de la création de
I’interface. Pour accéder aux structures Multidimensionnelles, en complément du module
Base SAS, vous devez obligatoirement avoir le module SAS OLAP Server sous licence
sur le server SAS. Pour établir la connexion, deux choix sont possibles : la combinaison
des modules SAS/CONNECT et SAS/IntrNet®, ou alors le module SAS® Integration
Technologies.

Pour commencer, a I’ouverture du produit, il faut créer un projet a partir du menu « File >
New » et choisir le type d’interface choisie, par exemple « Application ». La validation se
fait en cliquant sur « Ok » et « Finish ».

Il faut ensuite créer un objet de type « Viewer » puis un « Model » qui définit les données

a utiliser. Pour ce faire, la suite d’actions suivantes doit étre réalisée :

v Dans la barre d’objets, onglet « Data Viewers», glisser-lacher d’un objet
« Multidimensional Table View » dans le rapport grace a I’icone &

v' Dans la barre d’objets, onglet « SAS », glisser-lacher d’un objet « SAS Multi-
dimensional data sets » (&) dans la zone occupée par le « viewer ». C’est & cet instant
que s’effectue le choix du serveur.

Il reste ensuite a définir la connexion aux données.

Dans la fenétre « Components », la fenétre d’acces apparait aprés avoir cliqué droit sur
« Multidimensional TableV3Interfacel » et choisi I’élément « Customizer ». La connexion
au serveur s’établit et la liste des sources de données accessibles apparait.

La table multidimensionnelle & analyser est selectionnée dans I’onglet « Source de
données ». Il faut encore répartir les éléments dans le tableau. Cela s’effectue dans
I’onglet « Requéte ».

b Custormirer - TetFMninm hiddsrrieeisional TabilevSinterface 1 x| Tt - 1 Sl idiesencional TableV S nterlace ] x|
F [TestaMain mumdimensionalTaslevIineriacel =l 7 [TestiMain multidimensionalTablev3interacet =
e us|ﬂuuu0le|lnle-\’alle‘=| groupes | Valeurs calculées | Totaux| | Générsi| Source des donneas neuuele||me~a||es|soua-gmunea Valaurs calsulees|Tmm|commanuae]
& [Eolonned
|
MODB WORK CURE_ESEA (SASUSER WORK CUBE_EASAN Séectionné
*e. Temps (Year, Quarter, Month)
El
|
=
JE (1
¥ Masquar (s osllé de i statistigua st
Figure 16 : sélection de la source de données Figure 17 : Répartition des dimensions et indicateurs
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Apres avoir validé ces choix, le test d’alimentation du tableau se fait en sélectionnant
« Build > Execute » a travers le menu.

Le tableau alors accessible, offre un ensemble de fonctionnalités qui permettent une
exploitation totale des données multidimensionnelles.

Année 1993 ‘Année 1994
- |Actual Sales | Predicted Sales|Actual Sales|Predicted Sales
$121,020.00] $119,320.00) $125970.00 $113,690.00
§1 2?,404.'00§ $117,119.00§ $11s,594.nu: $114,436.00
$121,DE3.UU% $123,763.UD% $116,296.0 . ;

'fﬁcber'le:dét_awl
Trier les données ]

Pl premiers

Waleurs calculées. .

‘Totatne.

Sﬁus-gtﬁupgs..._-

Mise en surbrilance de I'exception. .
Requéte.. .

Exporter vers Ecel

Faire pivoter

Présentation des Ibelés de lgnes *

et Ee T

Figure 18 : Tableau produit sous WebAF.

3.2.6 WebEIS™

La distinction entre WebEIS et le produit précédent se fait essentiellement sur les sources
de données. Les pré-requis sont identiques.

Le processus d’alimentation du tableau final se fait en créant un nouveau projet
(renseignement du nom et de la premiére section). Une fois le serveur sélectionne, il faut
saisir les caractéristiques de la source de données et la répartition initiale des éléments
dans le tableau (voir figures 16 et 17).

Il suffit alors de glisser un objet « Table » (ﬁ) de la barre d’objets vers le rapport vide
pour que les données apparaissent dans le tableau. Il est alors possible de passer en mode
apercu, par le menu « Affichage > Mode apergu», pour profiter des différentes
fonctionnalités qui sont accessibles.
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Figure 19 : Tableau en mode apergu, produit sous WebEIS

3.2.7 MDDB Report Viewer

Le MRV (MDDB Report Viewer) est fourni avec SAS/IntrNet. Les pré-requis sont donc
liéss a ce produit. Base SAS, SAS/EIS ou SAS/OLAP Server, SAS/GRAPH et
SAS/IntrNet® doivent étre sous licence.

Sans détailler I’architecture, les données et les méta-données (repository et repository

manager) sont le plus souvent sur un serveur different du serveur web.

Les éléments a paramétrer, en plus des données et méta-données, concernent surtout

SAS/IntrNet. 1l s’agit de :

v' L’application broker qui réside sur le serveur web. C’est un programme CGI qui
recoit les demandes des utilisateurs et les envoie a I’application server.

v' L’application server qui réside sur le serveur SAS. Il s’agit d’un processus SAS qui
est & I’écoute des demandes envoyées par I’application broker

En version 8.2, il est nécessaire d’inclure la déclaration du repository manager et des
librairies contenant les données afin que toutes ces informations soient accessibles a
I’application server. Ces déclarations se font dans la procédure APPSRV qui est exécutée
au lancement de I’application server.

proc appsrv unsafe='&";%'"'
&sysparm;
allocate file sample '!SASROOT\intrnet\sample';
allocate library samplib '!SASROOT\intrnet\sample' access=readonly;
allocate library sampdat '!SASROOT\intrnet\sample' access=readonly;
allocate library tmplib 'c:\Environnement SAS\IntrNet\default\temp';
allocate library RPOSMGR 'C:\Environnement SAS\Multidimensionnel\Rposmgr';
allocate library SDONNEES 'C:\Environnement SAS\Travail\Sdonnees' ;
allocate file logfile 'c:\Environnement SAS\IntrNet\default\logs\%a_%p.log"';
proglibs sample samplib %ifcexist(sashelp.webeis) sashelp.webprog ;
proglibs sashelp.websdki ;

datalibs sampdat tmplib RPOSMGR sdonnees ;
log file=logfile;

run,

Exemple 4 : code de la procédure APPSRV
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L’exemple ci-dessus montre la déclaration obligatoire du repository manager, instructions
allocate et datalibs, et celle de la librairie SDONNEES qui contient les données. Il n’est
pas nécessaire d’exécuter d’instruction allocate pour la librairie car le chemin est connu de
SAS (librairie permanente).

Une fois ces éléments en place, il ne reste plus qu’a lancer le MRV gréace a la commande
suivante qui affiche les sources de données disponibles dans le repository SOURCE :

http://localhost/scripts/broker.exe?_program=sashelp.webeis.rptseld.scl& _service=default&metabase
=SOURCE&Nbhgtype=color&bg=gray&class=sashelp.override.myweb.class

Il faut alors choisir une source de données et valider en cliquant sur le bouton « Next ». La
fenétre de sélection des dimensions et indicateurs apparait alors. Le choix des éléments se
fait simplement grace a la souris et I’affichage s’effectue apres avoir cliqué sur « Report ».

[ N Ty ETy e ey e

Figure 20 : sélection des dimensions et indicateurs Figure 21 : Affichage des données par le MRV

Cette solution a I’avantage d’offrir les fonctionnalités de navigation classique et de
n’utiliser aucune composante SAS sur les postes clients. Seul le navigateur web est
nécessaire.

3.3 L’exploitation externe

3.3.1 Ole DB

Ce standard du marché autorise I’acces par une application tierce, Microsoft Excel par
exemple, a des données multidimensionnelles qui ne lui sont pas propres, les Mddbs SAS
par exemple. Il faut évidemment que les deux produits (le client et le fournisseur)
supportent ce standard.

Plusieurs étapes sont aussi nécessaires pour utiliser cette solution.
Il faut tout d’abord installer le client OLE DB sur chaque poste en exécutant le

programme « 0oscl30.exe » qui se trouve dans le répertoire mddbservimisc sous la racine
SAS.
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Les sources de données que I’on souhaite alors utiliser dans un applicatif tiers doivent
posséder I"attribut Olapmeta comme décrit précédemment.

Une fois cette installation effectuée, le fournisseur SAS, en I’occurrence une session SAS
qui écoute sur un port donné doit étre lancée. Cette session se lance grace a la commande
AF suivante : « af c=sashelp.opnolap.listener.scl port=NumPort».

A partir de cet instant, il ne reste plus qu’a définir les données a atteindre dans I’applicatif
tiers. Dans Microsoft Excel, cette déclaration se fait dans la fenétre « Choisir une source
de données » accessible par le menu a partir de « Données > Données Externes > Créer
une requéte ».

Il faut alors choisir I’onglet « Cubes Olap » et double cliquer sur « Nouvelle source de
données ». Les éléments suivants sont alors requis :

v" Nom de la source Le nom approprié aux données a atteindre

v Fournisseur OLAP  Dans notre cas, SAS. Elément a choisir dans une liste

v" Connexion Parametre de connexion a la session SAS
e Server name Adresse Ip du serveur et port d’écoute
o User Sans intérét en dehors de CFO*
e Password Sans intérét en dehors de CFO*
v" Cube SAS Sélection dans une liste du Mddb a connecter
x|
Ok |
Annuler i

Créer une nouvelle source de donn’e’i;gﬁ;. 2]

Donnez un nom & la nouvells souce de données
1. |Cude Fmimddb

Sélectionnez un fournizseur OLAP pour la base de donnédes :
@l = ISAS OLE DB for OLAF Provider for SAS/MDDE Server ;I

Cliguez sur Connexion et tapez les informations requises par le faumisseur ;

Selectionnez le cube contenant les informations desirges
4. |SDONNEES FMTMDDE (SOURCE) =

I Enregistrer lidentité et le mot de passe de Futilizateur

@J oK | Annuler

Figure 22 : Création d’une nouvelle source de données OLAP

Il ne reste plus alors qu’une seule étape dans la création du rapport : I’assistant tableau et
graphique croisés dynamiques qui gere la disposition des données. Il est donc possible
d’utiliser cet assistant pour construire son tableau ou son graphique mais ce n’est pas
obligatoire. En cliquant directement sur le bouton « Terminer », un tableau vide apparait
avec une boite d’outils.

1 CFO se nomme désormais FMS

19



—ioix
A B [ c I ] [ E [ F [ G | i
1 Déposer champs de page Ici | i—|
2
&)
)
|5 |
6 |
il
| 8 |
=
10|
|11
| 12|
|13
14 |
115
16
17 =y s
B
19| Tableau croisé dynamioue ~ | #9 4 (@ == *= | ¢ | %@
%% = Géograp... Temps &
E5 @ PCTSUM.. SUMoOF ..,
n = -
24
125 |
R
144 [» [pi[Feuill ¢ Feulz 7 Feuils 7 1«1

Figure 23 : Tableau initial avec la boite d’outils

La boite d’outils contient différentes options (forme de la représentation, format
automatique, assistant, actualisation des données, ...) ainsi que les données exploitables
(hiérarchie, indicateurs).

Pour alimenter le tableau, ou le graphique, il suffit de sélectionner les données et de
réaliser un glisser-lacher vers la zone souhaitée (rupture page, dimension ligne ou
colonne).

Au final, le tableau obtenu possédera les fonctionnalités de navigation élémentaire d’une
source OLAP. Il sera par exemple possible de naviguer dans la hiérarchie « Géographie »
en double-cliquant sur la cellule, modalité, a analyser, pour que le niveau inférieur soit
affiché.

Eassest —Io/xi
A | B c I D [ [ —
1 Dépaser champs de page | |
|2
3 Year  ~|
| 4 |Country ~|Region Divigion Donnges ~|Année 1933 Année 1994 |Total*
| § |Canada Est Congormmateur PCTSUM of ACTUAL | 45,95976822 47 70262005| 46,02590109
B | SUM of ACTUAL 29474 30222 59636
7 Education PCTSUM of ACTUAL | 54 04023078 5229737195 53,17409691
1B SUM of ACTUAL 34656 33133 57789
[ 8 PCTSUM of ACTUAL Est ™ 5299124112 50,29372073] &1 ‘EWEAEUE'
|10 SUM of ACTUAL Est * 64130 53355 127485]
[ 11] Quest PCTSUM of ACTUAL | 47 00875305 49 70627927 | 40 38454950
12 SUM of ACTUAL 56890 B2615 119505]
13 |PCTSUM of ACTUAL Canada * 327544069 34 90827468| 33 51863441
14 | SUM of ACTUAL Canada ™ 121020 1255970 246990
| 15 |Allemagne PCTSUM of ACTUAL | 3445225465 32 BRA268RI| 33,6528067
16 SUM of ACTUAL 127404 118584 245998
| 17 |Etats-unis PCTSUM of ACTUAL | 32,76333845 3222745663 | 32,49855688
18 SUM of ACTUAL 121063 116296 237343
18 | Tatal PCTSUM of ACTUAL * 50,58933314 49 41006586 100]
[ 20 Tatal SUNM of ACTUAL * 369477 360860 730337
i
= Tobleas rosé dyrerioue ~ | 20l B =2 73| ¢ | @[
|24 = Géogap..  Temps »~ m
%ﬁ— & PCTSUM., SMof.. i
[ AT Feuitt (Feile {Fai ) v [ Olp

Figure 24 : Exemple de tableau Excel

Méme si OleDb n’offre pas toute la richesse des fonctionnalités attendues par
I’exploitation d’une table multidimensionnelle SAS, ou autre d’ailleurs, les fonctionnalités
fournies sont tout de méme intéressantes.
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4 Conclusion

Que I’exploitation des données multidimensionnelles SAS soit plus riche par les produits
SAS, cela n’a rien d’étonnant puisque SAS fournit un panel de solutions utilisateur qui se
décline selon I’architecture et le domaine (web, client lourd, ...) souhaités.

Que SAS fournisse a travers OleDb un acces extérieur a ses données
multidimensionnelles, cela ne semble pas non plus trés étonnant. Pourtant cette nouvelle
norme est récente et I’ensemble des éditeurs décisionnels du monde OLAP n’a pas encore
fait I’effort de rendre compatible leur produit avec OleDb.

L’importance de I’utilisation de données multidimensionnelles dans un projet décisionnel

n’est plus a démontrer. Des efforts seront donc encore faits pour fournir aux utilisateurs
des fonctionnalités enrichies et de nouvelles méthodes d’acces.
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